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Introduction 
BIOMstat performs many of the standard statistical computations needed in biological 
research.  It includes modules for descriptive statistics, analysis of discrete and meristic data, 
analysis of variance and of covariance, regression and correlation analyses, and non-
parametric analyses.  BIOMstat is also designed to be easy to use and appropriate for use in 
the classroom.  Analyses are selected from a hierarchical system of buttons within folders 
along the left side of the main window and the parameters for a particular analysis are 
specified by filling-in information and checking options in the form displayed to its right.  The 
results of the computations appear in output windows whose contents can be examined, 
printed, copied and pasted to other Windows programs, or saved to a file.  Icons are available 
on a toolbar for plots appropriate for the particular analysis just completed. 

Version 4 of BIOMstat was developed to accompany the 4th edition of the text Biometry (Sokal, 
R. R. and F. J. Rohlf, 2012. Biometry. W. H. Freeman and Co.: New York).  An option can be 
selected so that the results of the computations are cross-referenced to specific pages in 
Biometry (relevant discussions in the text and Boxes showing the computational steps).  
However, the methods are general and this software can be used in conjunction with other text 
books.   
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Most of the statistical computations in this program are based on well-tested algorithms 
developed in the original FORTRAN versions of the program (BIOM, by FJR) first published 
as an appendix to the first edition of Biometry back in 1969.  However, version 3 has major 
changes over the earlier versions.  The previous suite of separate FORTRAN programs have 
been translated to Pascal and combined into a single program.  A MS Windows-based user 
interface has been added which makes the program much easier to use than previous versions.  
In addition, new statistical methods have been added, taking into account some of the new 
methods added to the 4th edition of Biometry.  Version 3.3 added many types of plots 
appropriate for the analyses included in this program.  There are, for example, histogram plots 
so one can see the general distribution of ones data, scatter plots to show relations between 
pairs of variables, and special plots appropriate for particular analyses.  The help file has 
examples of all the types of plots. Version 4.0 added further refinements and it takes 
advantage of additional features that Windows 7 makes possible. 

This version was written using Delphi 2007 by F. James Rohlf. Early code and design were 
made by Dennis E. Slice.  Dean Adams helped by testing the program and doing his best to 
find ways in which the program could be made to crash. 

Once BIOMstat has been installed, users are encouraged to make use of the extensive help file 
as it describes all of the statistical methods included in BIOMstat. The purpose of this 
UserGuide is just to provide instructions on installation and getting started.   
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Installation 

System requirements 

1. A PC-compatible computer with MS Windows Vista, 7 or 8 installed. It works well on 
64 bit versions of Windows. 

2. A hard drive with at least 10 MB of available disk space. 

Installing BIOMstat 

The following is a set of step by step instructions for installing the software.  Minimal 
familiarity with using MS Windows is assumed. 

1. Start Windows. 

2. Insert the BIOMstat Install CD as appropriate or else place the downloaded setup 
program in a convenient folder. Double-click on the setup.exe file unless it starts 
automatically from the CD. 

3. The Install program will request the unlocking code provided with the software.  Click 
on the Next button to continue the installation process or the Back button to return to a 
previous screen. 

4. The Install program will ask for the drive and directory where you would like to install 
BIOMstat.  You may accept the suggestion or enter a new location.  A new directory 
will be created if the directory does not exist already.  Note: you can reuse the same 
directory as earlier versions. Click Next to the continue installation. 

5. When the setup program finishes you should have a new folder on the Start menu 
called BIOM (unless you specified a different name) with icons for the BIOMstat and 
BIOMedit programs, their help files, and an Uninstall program (see below).  The 
following files will be placed on your hard disk: biomstat.exe, biomstat.ovr, 
biomstat.chm, biomedit.exe, readme.txt, and biomstat.pdf.  Sample data 
files will be placed in the BIOM\DATA directory. 

When you run the BIOMstat program the first time you will be prompted to enter your name, 
institution, and the serial/registration number. 

Uninstall procedure 

Should you have to remove this software from your computer you only need to double-click 
on the Uninstall icon in the BIOM folder on the startup menu.  This will delete the files and the 
directory for BIOMstat.  You do not need to delete BIOMstat in order to install a new version.   
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How to use BIOMstat 
After installation, there should be a BIOMstat icon in the BIOM folder.  Double-click on that 
icon to start the program. Before you can make use of the program to analyze your own data 
you will have to prepare data files in a format compatible with BIOMstat.  Files can be either 
ASCII files or Excel files.  With the database version of BIOMstat, dBase, Paradox, FoxPro, 
Access, and other standard database files can also be used.  See the chapter on data file formats 
and the help file for more information. 

The next section gives a tutorial on how to use BIOMstat to carry out a single-classification 
analysis of variance using the sample data singl.dta (note: this Courier font will be used 
in this documentation for names of files, for data contained within them, and for information 
the user has to enter).  Sample data files are placed in the TESTDATA subdirectory during 
installation and are also available as part of the help system.  The Ariel font will be used to 
refer to information displayed on the screen by the program (such as names of fields where the 
user has to enter information). 

A sample session 

The initial screen consists of a vertical series of buttons grouped in folders along the left side of 
the window (see below).  The first step is to find the folder corresponding to the desired type 
of method.  For example, the “Basic statistics” button is located within the “Descriptive 
statistics” folder.  In the example shown below large icons are shown.  They can be changed to 
smaller icons in the Main Options dialog that can be opened from the Options menu.  
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The screenshot shown above shows what it will look like after clicking on the “Basic statistics” 
icon. It shows on the right the particular options needed for this module. 

If you have a data file ready for processing you should click on the “Data” button to load your 
data file by selecting it from the list in the file-open dialog box.  An example of the file-open 
dialog box is shown below. 

 

You can either type in the name of the file or use the controls shown above to click on a 
filename (perhaps after having changed to another directory).  In the “Files of type” window 
you can also select “Excel files”.  

Alternatively, you can select “Edit” from the File menu to load the data editor that allows you 
to modify an existing file or to create a new one. Shown below is an edit session displaying the 
first part of the ancova.dta file. 
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When the data file is complete, you can select the variable in your dataset that correspond to 
the dependent variable (LogAct in the ancova.dta file) and the variable that groups the data 
into samples (Group in this example).  A completed dialog is show below.  Note that the title 
and the number of data records in the dataset are displayed. Note that the file must first be 
saved to disk before it can be loaded (or reloaded) into a BIOMstat module. 

The “Include original data” checkbox is present in the dialog box for every analysis.  If it is 
checked then the original input data will be included in the output listing (useful to make sure 
the program has interpreted your data properly but may not be necessary if you are making 
many analyses with the same dataset).  If the “Append” box is checked then the output of the 
next run will be appended to any previous output of this program.  This can be useful if you 
are studying the effects of different options and you would like a single print-out of all the 
runs.  The “By” field, present on most dialog boxes, is used to specify an input variable that 
divides the data into blocks that are to be analyzed separately.  The output listings are not kept 
permanently so you should use the “File|Save as” item on the listing window’s menu to save 
any you wish to keep (they will be saved as plain ASCII text files).  

You can then select (e.g., click with the left mouse button) the “Compute” button to actually 
perform the computation.  A new window will pop-up and display the listing file containing 
the results.  An example is shown below in which part of the listing file is visible in the 
window. 
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Scroll the window up and down to study the results, save it to a file, print it, or copy part of it 
and paste it into some other Windows program -- such as a wordprocessor.  To close the 
output window, you can either double-click on the upper left corner of the window, press the 
A-4 keys or you can also click on the x in the upper right corner of the window).  
Selecting “File|Close” on the menu minimizes the listing window rather than closing it. 

Finally, one can click on the graphics icons on the toolbar just below the menu line  Clicking 
the histogram icon results in the following plot. 



10 BIOMstat 4.0 How to use BIOMstat 

 

The Plot Options window for this plot can be opened from the Options menu of the output 
window or by right clicking on the plot. This window allows you to change the class marks, 
class interval, scales for the abscissa, and the properties (color, line thickness, and pattern) of 
the histogram bars.  Examples of the various graphics options dialog boxes are shown in the 
Graphics section below (page 11). 

Main Options 

If you select “Options|Main Options” on the menu of the main window, a dialog (see below) 
will be displayed that lets you to set a number of options such as:  

 Whether the output listing cite references to the 3rd or 4th editions of Biometry. 

 Whether small or large icons will be used in the main window. 

 Whether the dialog boxes should try to guess which variables go in which fields?  They 
assume that grouping variables (if present) correspond to the initial variables and the 
dependent variable is listed last. 

 Whether "fly-by" help hints are to be shown when the mouse cursor passes over a control 
in one of the dialog boxes. 

 What 3 character extension is used for data and listing files. 

 The default field width and decimal places for listing data. The use of this field can force 
more precision in the output listings. 

 The editor can be changed from the default Windows notepad editor.  The “Select” button 
to change this to an editor of your choice.  If you select a wordprocessor then make sure 
you save data files as plain ASCII text files. 
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Graphics 

Most of the computational modules provide plots that help one visualize the results of an 
analysis or to detect departures from its assumptions.  The set of available plots is indicated by 
the icons on the toolbar in the Results Window that contains the Listing Window.  The right-
most icons are always (except for the Mantel module) for a simple 2D x,y scatterplot if the 
current data file contains at least two variables and a 3D x,y,z scatterplot if the current data file 
contains at least three variables.  You can use these modules to plot any variable against any 
other.  This is sometimes useful for detecting problems in the data.  Place the mouse cursor 
over an icon to receive a "hint" about the type of plot it produces.  Click on the desired icon to 
produce a plot.  You can also select a plot from the View menu item. 

The size and aspect ratio of a plot can be changed by dragging a corner of the plot or maximize 
its window for better viewing.  You can also minimize the Listing Window to get it out of the 
way.   

The File menu options allow you to preview or print a plot and setup your printer.  

Select the “Options|Plot Options” menu item to display a dialog that allows you to set options 
specific to the current plot and also to set general plot options. The options specific to each plot 
allow you to customize the color and other attributes for the titles, subtitles, and any symbols, 
lines, and bars used in a plot.  The axes buttons allow you to adjust the scale and appearance of 
each axis.  Depending on the module, there may be check boxes that allow you to include or 
suppress the plotting of certain items.  The General button brings up the general plotting 
options (see below).  Press the "OK" button to accept the changes and close this window. 

An example plot-options dialog is shown below for the BASTAT module.  t 
allows one to change the attributes for the histogram and the axes. 
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Pressing the Y-axis button results in the following dialog box that allows you to change many 
aspects of the Y-axis in the current plot. 

 
For various plots, you can also change fonts, colors, plotting symbols, and histogram bars.  
Each have their own options window.  For example, the dialog box for changing the attributes 
of the bars in the Single classification anova histograms is shown below. 
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Clicking on the General button on a plot options dialog brings up a dialog box where you can 
control the general layout of the plot. You can change the color and other attributes of the plot 
background, the frame around the plot, the margin outside a plot, and the location of the 
legend (if appropriate). An example is shown below.  
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Data file formats 
To use your own data with the program you first have to prepare data files.  Data are in the 
form of a table or matrix with columns corresponding to variables and rows to the 
observations.  They may be stored as ASCII text files with special keywords (as described 
below), as Excel files (see below), or as database files (e. g., dBase, Paradox, or Access table 
files). The variables consist of both the measurements being analyzed and also numerical codes 
indicating the grouping of observations into samples. 

ASCII files 

There are four kinds of input records.  Each of them starts with a keyword and ends 

with a semicolon. 
title Title or comment about the data file.  It is used to label the output listing.  This 

record is optional. 
vars List of the names of the variables (columns) in the data table.  This record is 

required and must come before the data since it defines the number of columns 
that the program should process. Qualitative variables (those using 
alphanumeric codes) are indicated by the presence of the “$” character in the 
variable name. This character can be changed in the options dialog window.  No 
spaces are allowed within a variable name (but you can use the underscore “_” 
character). 

data The actual data follow this keyword.  The number of columns must match the 
number of variable names provided in the vars record.  The number of rows 
corresponds to the total number of observations.  The entries for each row must 
be separated by at least one blank, comma, or tab character.  Note: the Mantel 
module is unique in that it uses the “symmatrix” keyword instead.  It requires 
the data in the form of a lower ½ matrix including the diagonal.  There is no 
predefined limit to the number of records in any one dataset. 

end This indicates the last line of the file to be processed.  Information following this 
record will be ignored. 

Excel files 

The format for an Excel data file is quite simple – each variable corresponds to a 
column in the spreadsheet with the first value in each column taken as the name 
of the variable.  However, the variable labels must not contain any blanks.  As 
with the BIOMstat data files, qualitative variables are indicated by the presence of a “$” 

character within the variable name. There can be only one dataset in a spreadsheet.   

Optionally, the variables can be preceded by title and comment lines. The title cell (there can 
be only one) must start with ‘title:’. For example, cell A1 could contain the following string: 
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‘title: data from nutrition experiment’. One or more comment cells can be 
provided.  Each must contain ‘comment:’.  For example, cells A2 and A3 could contain the 
following: ‘comment: variable 1 was measured in mm’ and ‘comment: variable 2 
is in degrees Celsius’.  

Note: BIOMstat can only read Excel files (values changed in BIOMedit but they cannot be 
saved back to an Excel file). The changed file can be saved as an ASCII data file. An example of 
a data file in Excel is shown below (there are no title or comment cells in this example). 

 
An example with both a title cell (A1) and two comment cells (A2 and A3) is shown below. 
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Examples of ASCII data files 

Data file with a single variable (such as might be used with the Basic Statistics module).  The 
data elements cannot be entered with several on the same line since each line corresponds to 
an observation. 

title Aphid stem mother femur length data (BOX 2.1); 

vars FemLen; 

data 

3.3 

3.5 

3.6 

3.6 

3.6 

3.6 

3.8 

3.8 

3.8 

3.8 

3.9 

3.9 

3.9 

4.1 

4.1 

4.2 

4.3 

4.3 

4.3 

4.3 

4.4 

4.4 

4.5 

4.7 

4.4 

; 

end; 

 Data file for a 22 contingency table (such as used with the RC or Fisher modules).  The 
first two variables indicate the rows and columns and the third variable gives the cell 
frequencies. 

title Ant invasion data (Box 17.7); 

vars Species Invaded? f; 

data 

 1 1 2 

 1 2 13 

 2 1 10 

 2 2 3 

; 

end; 

 Example of a SYMMATRIX data file as used by the Mantel module.  The matrix is a 10x10 
lower ½ matrix (including diagonal). 
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title Genetic distances (Box 18.10); 

vars 3G 8L-11P 8F 8ABC 11YZ 11D 11X 3RS 8O 15L; 

SYMMATRIX 

0 

.02040 0 

.04143 .03944 0 

.01213 .02549 .05285 0 

.01246 .01362 .04473 .01682 0 

.02868 .03908 .04109 .02195 .04362 0 

.03393 .03347 .03313 .04774 .04928 .04567 0 

.03023 .02816 .08473 .02804 .02605 .05730 .05661 0 

.03784 .03229 .03276 .02445 .02767 .02986 .04330 .04805 0 

.05698 .06308 .07491 .03722 .03377 .06550 .10242 .05331 .03661 0 

; 

end; 

There are many examples of ASCII data files in the help file.  There are also sample listings 
and plots (with annotations) from every computational module. 
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Descriptions of methods 

Introduction 

Furnished below is a description of the common to most of the modules as well as a 
description of the BASTAT module as an example. See the help file (either online or the PDF 
file) included with the BIOMstat program.  Each section lists the purpose of the statistical 
method, its assumptions, how to setup the dialog box, and a description of the output listing.  
These sections are not intended to replace a good statistics text (such as Biometry) which would 
give much more detail about each method and how the results should be interpreted. 

There are two standard check-boxes on all of the dialog boxes statistical analyses (i.e., except 
for the estimation of n and the statistical calculator).   

 If “Include original data” is checked then a listing of the input data will be included in the 
output listing window.  This is useful to make sure that BIOMstat has correctly interpreted 
your data file.   

 If “Append” is checked then the output listing will be appended to the end of any previous 
listing for the current computational module. 

There are also four standard buttons on the dialog boxes for each statistical analysis.   

 Data, loads a data file into the program. 

 Compute, the entries in the dialog box are checked and the corresponding module 
executed. 

 Edit, the built-in edit program is executed using the currently selected data file.  You may 
choose which edit program is called if an error is encountered in reading the file (by default 
the Windows Notepad program is used) in the Options dialog box (page 10). 

 Help, the help file is loaded and set to display help for the current dialog box.  You can also 
just push the 1 key.  Note: the help is extensive.  It includes examples of data sets for 
every statistical method. 

Transformations 

The following data transformations are available for use in most of the computational 
modules: 
|Y| absolute value of Y 

Y square root of Y 

(Y+.5) square root of (Y+½) 
Y² square of Y 
ln Y natural log of Y 
log Y log to base 10 of Y 
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log (Y+1) log to base 10 of (Y+1) 

sin-1 (Y) arc sine of square root of Y (assumed to be a proportion) 

sin-1 (%) arc sine of square root of Y/100 (Y assumed to be a percentage) 
1/Y reciprocal of Y 

Y p
 Y to the power p, p furnished in the power field of the transformation dialog box. 

( Y
p

-1)/p The Box-Cox transformation.  The optimum value of p is estimated and then the 
power transformation used.  Only the Basic Statistics (page 21) and the 
Homogeneity of Variances modules allow the use of the Box-Cox transformation. 

Basic statistics 
Purpose 

Computes descriptive statistics for continuous variables.  The mean, minimum, maximum, 
range, standard deviation, variance, median, skewness (g1), kurtosis (g2), and their confidence 
limits are given.  A Kolmogorov-Smirnov test is also provided for a goodness of fit of the data 
to a normal distribution using the estimated mean and variance.  The Box-Cox transformation 
can be used to find the power transformation that results in the best fit to the Normal 
distribution.  This exponent can then be used for the power transformation in this and other 
modules of BIOMstat.  Bootstrap estimates of the mean, variance, and coefficient of variation 
can also be computed along with their parametric and nonparametric estimates of their 
confidence intervals. 

Assumptions 

These methods are based on the assumption that the variables are continuous, independent, 
and normally distributed (or can be transformed to approximate normality). 

How to use 

First use the Data button to specify a data file.  The module accepts either raw data in the form 
of a single column of values or a frequency distribution with the Variable field indicating the 
class marks and the Frequencies field indicating the frequencies for each class. Set the Alpha 

field to the probability level to be used in setting (1-)100% confidence limits.  

Dialog box fields: 

Data Select a previously prepared data file. 

Alpha Probability level to be used in setting (1-)100% confidence limits. 

Variable Select the dependent variable for the analysis and (optionally) a transformation. 

Frequencies Optionally, select the variable that indicates the frequencies for each class if the input date are 

in the form of a frequency distribution.  Otherwise, this field must be left blank. 

Bootstrap samples If a value greater than 0 is entered then bootstrap estimates and confidence limits of the 

mean, variance, and coefficient of variation will be computed. 
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Jackknife? If checked, then jackknife estimates of the mean, variance, and coefficient of variation are 

computed. 

By Optionally, select a variable that will be used to split the dataset into a series of separate 

analyses. 

Standard check boxes: Include original data, Append. 

Standard buttons:  Compute, Edit, Help. 

 

Output listing 

The output consists of a table of the various statistics computed -- mean, median, variance, 
standard deviation, coefficient of variation V, measures of skewness g1, and kurtosis g2. These 
are followed by their standard errors and confidence intervals where applicable.  Tests for 
skewness and kurtosis are followed by the D'Agostino-Pearson test, see D'Agostino et al. (1990) 

for the computational methods. The results of the δ-corrected Komolgorov-Smirnov test for 
goodness of fit to the normal distribution using the estimated mean and variance is given at 
the end.  Both Dmax and the delta-corrected statistics, g0 and g1 are given.  The Shapiro-Wilk 
statistic W is given along with its probability. 

If the resampling number is greater than 0, bootstrap estimates and their standard errors will 
be given for the mean, variance, and the coefficient of variation. Confidence limits are also 
computed both as an estimate plus or minus t times their standard error and also 
nonparametrically as the upper and lower α/2 values among the bootstrap estimates. 

If the jackknife box is checked then jackknife estimates of the mean, variance, and coefficient of 
variation will be computed. 

Histogram and normal quantile plots can be viewed.  

Output listing example 

The following example is based on the aphid data from Box 2.1 in Biometry. 
Data file: Box 2_1.DTA 

Title: Aphid stem mother femur length data (BOX 2.1) 

Total number of records in file: 25 

Variable: FemLen 

Alpha:   0.05000 

 

Total sample size = 25 

The following is a list of various statistics and their standard errors (where available). 
Results: 

 

             Statistic        Stand. error         Confidence limits 

                                                    (95.00%) 

 Mean         4.0040000000       0.0731391368     3.8291323683     4.1788676317 

 Median       3.9000000000       0.0916652802     3.6808383972     4.1191616028 

 Min          3.3000000000 

 Max          4.7000000000 

 Range        1.4000000000 

 Var.         0.1337333333 

 s            0.3656956841 

 V (%)        9.1332588424       1.3292234325     5.9552318139    12.3112858709 

 g_1         -0.0180738236       0.4636835008    -0.9270766016     0.8909289545 

 g_2         -0.9450804483       0.9017205463    -2.7128088237     0.8226479270 

The following gives the results of applying the Kolmogorov-Smirnov test for goodness of fit to the normal 
distribution. 
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Kolmogorov-Smirnov statistic 

Test fit to normal distribution using estimated parameters. 

  Dmax = 0.15086 

    Dallal & Wilkinson (1986) approximation to Lilliefors test: P > 0.1 

  Khamis delta-corrected statistics: 

    D_0 = 0.13702, D_1 = 0.16586 

    g_0 = 0.13702, g_1 = 0.12420, 0.05<P<=0.1 

Shapiro-Wilk test for normality: 
Shapiro-Wilk W = 0.95790, P =  0.3742 

Result of bootstrap sampling: 
Bootstrap statistics: 

 Statistic           Mean            Std             L1             L2 

      Mean   3.9755368000   0.0674634932   3.8432787752   4.1077948248 

       Var   0.1128235200   0.0215540140   0.0705682026   0.1550788374 

         V   0.0841437074   0.0084320402   0.0676132118   0.1006742030 

 

Nonparametric conf. limits): 

    Coeff       L1       L2 

     Mean   3.8640   4.0840 

      Var   0.0792   0.1502 

        V   0.0703   0.0981 

Results of Jackknife: 
Jackknife statistics and their standard errors: 

 Statistic           Mean             SE             L1             L2 

      Mean   4.0040000000   0.0731391368   3.8530482401   4.1549517599 

       Var   0.1337333333   0.0285258914   0.0748587870   0.1926078797 

         V   0.0918392506   0.0100809796   0.0710331314   0.1126453699 

 

Example of a histogram plot.  The class marks, tics, and the scaling of the axes have been adjusted from the 
defaults. 

 

 

Example of a normal quantile plot for the aphid data.  The general trend is that of a straight line which is consistent 
with sampling from a normal distribution. 
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  Basic statistics - technical details 

 The bootstrap estimates of the mean and coefficient of variation are based on a random 
sampling (with replacement) of observations from the entire sample. 

The jackknife estimates are based on the variation in the estimates with each observation left 
out in turn. 

 

 



  

Other software from Applied Biostatistics Inc. 

NTSYS-pc 
A data analysis system designed to help you discover patterns and structure in multivariate 
data.  It includes computation of various similarity and dissimilarity coefficients (including 
association coefficients and genetic distances), cluster analyses (includes UPGMA and 
neighbor-joining), ordination analyses (includes PCA, Pcoord, CVA, and MDSCALE), Mantel 
test, partial least-squares, and canonical correlation analysis.  It includes partial least-squares 
analysis and canonical correlation analysis for studying the relationships between two sets of 
variables..  It also includes Fourier analysis and the computation of partial-warp scores for 
both 2D and 3D coordinate data (useful for geometric morphometric studies). 

For more information or to place an order contact Exeter Software: 
47 Route 25A, Suite 2 
Setauket, NY 11733 
516-689-7838, FAX: 516-689-0103 
e-mail: sales@ExeterSoftware.com 
www URL: http://www.ExeterSoftware.com 


